Installation Guide
for the
Intel® Server Control

Order Number: 747116-010

This guide explains how to ingtall and launch the Intel® Server Control (1SC) software. ISCisa
server management tool that provides real time monitoring and alerting for server hardware,
emergency remote management, and remote server setup. It isimplemented using aclient-server

architecture.
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System Requirements

I SC contains two parts:

| SC Console Software
| SC Server Instrumentation Software

ISC Console Software alows interaction with the managed server. It can beinstalled on these
system configurations:

Windows NTT 4.0 server or workstation, Enterprise Edition
Windows' 98 Second Edition workstation
Windows 2000 workstation

ISC Server Instrumentation Software, when installed, creates a managed server that can be
managed from the system running 1SC Console Software. It can beinstalled on these systems:

Windows NT 4.0 server
Windows 2000 server
NetWare' server
UnixWare' server
Linuxt 6.2 server

Managed Server Requirements

| SC supports several Intel® motherboards. For a complete list of supported server motherboards
and qualified BIOSrevision levels, see the I SC release note files (ENUREADME.TXT and
ENUERRATA.TXT). The following requirements must be met for a managed server.

Windows 2000/NT Requirements

Windows 2000 Advance Server, NT Server 4.0 (SP 6a), or Enterprise Edition

64 MB of RAM

60 MB of available disk space

Windows NT SNMP or SNMP service installed (required only for connectivity to an SNMP
management console)

NetWare Requirements

NetWare 4.2 SP8a or 5.1 SP1 symmetric multiprocessing (SMP)
At least 95 MB of RAM
At least 60 MB of available disk space



Red Hat' Linux Requirements

If you intend to manage a Linux file server, it must meet the following minimum requirements:

* RedHat Linux 6.2 SBE 2 running in multiple-processor kernel
» 32MB of RAM
e 60 MB of available disk space

SCOT UnixWare Requirements

If you intend to manage a UnixWare file server, you must have an account with root privileges
availableto you. The server must also meet the following minimum requirements:

e SCO UnixWarev7.1.1

* 32MB of RAM

e 60 MB of available disk space

Additional Requirements for DMI-SNMP Translation

Simple Network Management Protocol (SNMP) support must beinstalled if you want to integrate
ISC with an SNM P-based management framework. For SNMP installation information, see your
Windows NT, NetWare, or UnixWare documentation.

On the managed server, you should consider the following issues when configuring SNMP:
e Community string names for SNMP Get and Set operations

e Community string names for sending traps

* The degtination address for the management console receiving the traps

On the management console, you should consider the following issues when configuring SNMP:

e Compiling the MIBs into the SNM P management consoles
» Integration of ISC trapsinto SNM P management consoles

Console Requirements

Console System requirements may change when snapping into one of the supported management
applications. Pleaserefer to their installation requirements for additional information.

I SC Console Software integrates into an Enterprise System Management Console or it can be
installed on a stand-alone console. The required Enterprise System Management Consoles are:

1. Intel® LANDesk® Server Management 6.xx
2. HP OpenView' Network Node Manager 6 for Windows NT
3. CA UnicenterTNG' 2.2 for Windows NT

A stand-alone console manages | SC-enabled servers without Enterprise System Management. Itis
implemented as an ActiveX control that runs within its own container or third party container
application (e.g., Microsoft™ Management Console, Internet Explorer v5.0 or later, or Netscape
Navigatort v3.0 or later with ActiveX™ snap-in). Y ou can choose the stand-alone environment
during setup. If you do not choose the stand-al one environment and no management console is
present, the | SC software will not install.
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Windows 98 Second Edition

e Intel® Pentium® microprocessor or higher.
* Atleast 32 MB of RAM.
e Atleast 10 MB of available disk space.

»  Microsoft Windows compatible modem must be used for if you connect to the server by
modem.

Windows 2000/NT

e Windows 2000/NT Server, or Workstation 4.0 (SP 6a), or Enterprise Edition.
e Intel Pentium microprocessor or higher.

» Atleast 64 MB of RAM.

e Atleast 10 MB of available disk space.

+  For Windows NT, Remote Access Service must also be installed. If it isnot installed the Direct
Platform Control (DPC) component will not install.

e Microsoft Windows compatible modem must be used for if you connect to the server by
modem.

Installation Guide for the Intel Server Control 5



Service Partition and Population

The service partition is a special hard disk partition. It is established when initialy setting up the
server system and contains utilities, diagnostics, and other software required for remote
management. The service partition is not marked as an active partition and the server will only
boot from it by a special request. It is not normally visible to the server user because it hasa
special non-standard partition type that does not appear as an accessible file system to the end user
operating system. However, low level disk utilities can see the partition entry as an unknown type,
and recognize its space.

The utilities and diagnostics on the service partition can be run locally or remotely. In order to run
the utilities and diagnostics the server must boot from the service partition. Remote execution is
available from the Direct Platform Control (DPC) Console Manager and System Setup Utility
(SSU) Client.

Service Partition Installation

It is recommended that you install the service partition:

e Onaclean formatted hard drive with no partitions defined.

» Beforeinstalling any operating system.

It can also be installed on a hard drive that contains partitions, providing there is unpartitioned
space and one free entry in the partition table. However, these are not recommended because some

operating systems may no longer boot if partitions are added or removed after that OS has been
installed.

Requirements

e The SP can be on any of the first 8 BIOS-supported physical hard drives.

*  SPhard drives must support BIOS INT13.

* Current ECO BIOS must be installed.

* Remove old service parititions and create service partition with current Software Kit CD.

e Atleast 50 MB of unused (not partitioned) hard drive space. On large hard drives this unused
space must be within the first 8 GB.

e A service partition does not already exist on the hard drive.

[] NOTE

There are commercia utilities that can resize existing partitions to free space
if moreisneeded. Alternately, you can add alow capacity hard drive for the
service partition.
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Installation

This procedureisfor installing the SP on a clean formatted hard drive only.

A CAUTION
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11.

12.
13.
14.
15.

16.
17.

18.
19.
20.

21.
22.
23.

To prevent dataloss, do not attempt to run the ingtallation utility from any
device other than the Software Kit CD.

Backup al data on all hard drive.

Disable all system features that prevent writing to the hard drive boot sector.

Insert the Software Kit CD into the CD-ROM reader.

Restart the server.

When the “F2 to enter setup” message appears, quickly press F2 to enter Setup.

In Setup, use the arrow keys to select the Boot menu.

Use the arrow keys to select Boot Device Priority then press Enter.

Select ATAPI CDROM and use the + key to move the selection to the top of the list.
Press F10.

. Select Yes to confirm saving of the current settings and press Enter. The server restarts and

boots from the Software Kit CD.

When the Server Board CD-ROM menu appears, use the arrow keys to select the Utilities menu
and press Enter.

Select Run Service Partition Administrator and press Enter.

Choose item 3 - Create service partition (first time).

Follow the instructions on your screen to select the hard drive for service partition installation.
The utility creates the service partition and informs you that it will reboot the server when you
press any key.

The server reboots from the Software Kit CD.

When the Server Board CD-ROM menu appears, use the arrow keys to select the Utilities menu
and press Enter.

Select Run Service Partition Administrator and press Enter.

Choose item 4 - Format service partition and install software.

Follow the instructions on the screen to format the service partition and install the partition
software.

Quit the Server Board CD-ROM menu.

Remove the Software Kit CD from the CD-ROM reader.

You can now install the user operating system.
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Boot

the Server from the Service Partition

Boot the server from the service partition when you want to run the utilities and diagnostics found
on the service partition. Y ou can reboot a server:

Locally

Remotely

Using the DPC console manager
Using the Client SSU

Locally Booting the Server from the Service Partition Boot

1

arON

o

Restart the server.

When the “F2 to enter setup” message appears, quickly press F2 to enter Setup.

In setup, use the arrow keys to select the Server menu.

Select Service Boot and press Enter.

Choose Enabled and press Enter. The Service Boot option resets to Disabled after the next
system boot.

Press F10.

Select Yes to confirm saving of the current settings and press Enter. The server restarts and
boot from the service patrtition.

Remotely Booting the Server from the Service Partition Boot

You can remotely boot the server from the service partition using the DPC Console Manager or the
SSU Client.

Configuring EMP and Console Redirection Settings

To take advantage of DPC and CSSU features, the Emergency Management Port (EMP) and
console redirection settings must be configured using the server System Setup Utility (SSU).

ONeOOkwWNPE

©

10.

11.
12.

Insert the Software Kit CD into the CD-ROM reader.

Restart the server.

When the “F2 to enter setup” message appears, quickly press F2.

In Setup, use the arrow keys to select the Boot menu.

Use the arrow keys to select Boot Device Priority then press Enter.

Select ATAPI CDROM and use the + key to move the selection to the top of the list.

Press F10.

Select Yes to confirm saving of the current settings and press Enter. The server restarts and
boots from the Software Kit CD.

When the Server Board CD-ROM menu appears, use the arrow keys to select the Utilities menu
and press Enter.

Select “Run System Utility” under the “Utilities” menu. You will see SSU executables
installed the first time and then the Server SSU launches.

In the Available Tasks list select Platform Event Manager and click OK.

Click the Configure EMP button.
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13. Enter the following in the Emergency Management Port (EMP) dialog box:

Option Entry

Enter New Password: Enter the EMP password, up to 16 characters.

Verify New Password: Re-enter the EMP password.

ESC Sequence: +++ (default)

Hangup String: ATH (default)

Modem Init String: ATE1QO0V1X4&D0S0=0 (default). May require change based on the installed
modem requirements.

System Phone Number: The phone number to access the EMP port connect to port COM2.

Access Mode: Always Active. [default is Preboot]

Restricted Mode: Disable. [default is Enable]

Connection Mode: Modem Connect(default) for modem connections to COM2. Serial Connect

for direct serial connections to COM2.

14. Click Save, then Close.

15. Exit from the Server SSU.

16. Quit the Server Board CD-ROM menul.

17. Remove the Software Kit CD from the CD-ROM reader.
18. Reboot server and select F2 to re-enter BIOS setup.

19. Select Server.

20. Toggle “LAN Redirection” to enable.

21. Press “ESC” and save changes before rebooting.

Configuring the Server for LAN Access

To take advantage of LAN access and BMC LAN-Alerts features, server settings must be
configured using the server System Setup Utility (SSU). After the settings are initialized they can
be changed using the Client System Setup Utility (CSSU).

If you are going to define a SNMP community, be sure to do it before installing ISC.

1. Insert the Software Kit CD into the CD-ROM reader.

Restart the server.

When the “F2 to enter setup” message appears, quickly press F2.

In Setup, use the arrow keys to select the Boot menu.

Use the arrow keys to select Boot Device Priority then press Enter.

Select ATAPI CDROM and use the + key to move the selection to the top of the list.

Press F10.

Select Yes to confirm saving of the current settings and press Enter. The server restarts and

boots from the Software Kit CD.

9. When the Server Board CD-ROM menu appears, use the arrow keys to select the Utilities menu
and press Enter.

10. Select “Run System Utility” under the “Utilities” menu. You will see SSU executables
installed the first time and then the Server SSU launches.

11. In the Available Tasks list select Platform Event Manager and click OK.

12. Click the Configure LAN button.

ONoOk~WDN
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Option
Enable LAN Alerts:
Enter New Password:

Verify New Password:
LAN Access Mode:

SNMP Community String:

IP Configuration:
Host IP Address:
Gateway IP Address:
Subnet Mask:

Alert IP Address:

13. Enter the following on the BMC LAN Configuration (LAN) dialog box:

Entry
Click to enable BMC LAN-alerts.

Enter the BMC LAN Configuration password, up to 16 characters. Default is
NULL. This will be used for all LAN connections in CSSU, DPC, PIC, and
BMC LAN-alerts.

Re-enter the BMC LAN Configuration password.
Full Access . [default is Disabled]Allows DPC and CSSU access via LAN.

Public (default) unless there is predefined SNMP host to receive SNMP traps
from BMC LAN-Alerts. Must be from 5 to 16 characters.

Static (default) unless you are using DHCP for IP hosting, then select DHCP.
Enter the IP address of the server if you are not using DHCP.
Enter the IP address of the router if you are not using DHCP.
Enter the subnet mask of the hosts on the subnet if you are not using DHCP.

Enter the IP address of the server to receive SNMP traps for the community
defined with the SNMP Community String. Enter 0.0.0.0 (default) if a
community is not defined.

14. Click Save, then Close.
15. Exit from the Server SSU.
16. Quit the Server Board CD-ROM menul.

Using the DPC Console Manager

1. Connect to the appropriate server.
2. Select Reboot Service Partition from the Action menu.

Using the Client SSU
1. Select (Re)Connect from the Server menu.
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Installing ISC

Managed Server Preparation

I SC uses the event-logging feature of the BIOS for system management status and information. To
enable this feature for each server to be managed with I SC, you must boot the server(s) using the
System Configuration Utility (SCU) or System Setup Utility (SSU) and set the appropriate options
under System Management Options. For motherboard-specific settings and values, see the ISC
release note files (ENUREADME.TXT and ENUERRATA.TXT).

[] NOTE

It is possible to configure temperature and voltage threshol ds on the server
system using the SCU or SSU. However, the thresholds set with the SCU or
SSU arein effect only for a short time during the system boot process. PIC
overwrites these thresholds when the OS loads. It is recommended that all
threshold changes be made using Platform Instrumentation Control (PIC).

Compatibility and Upgrade Issues

The following paragraphs describe compatibility and upgrade issuesfor:

e LSCandLDSM

e NetWare

e WindowsNT

*  Windows 98 Second Edition
* UnixWare

* Red Hat Linux

¢  Windows 2000

LSC and LDSM

If you have earlier versions of LSC or LDSM on your network, be aware of the following:

e Vesionsof LSC integrated with LDSM (e.g., LDSM with LSC55) are not supported
under ISC.

e ThelSC-managed server installation will not upgrade the DMI service provider or any DM
database that is aready installed on the managed server. However, if a service provider isnot
found, ISC installs a DMI 2.0 service provider.

e ThelSC server ingtallation process installs the remote procedure call (RPC) transports (DCE
and ONC) if they are not available on the managed server.

*  |SC shipswith the DMI 2.0s Service Provider for Windows NT. The 2.0sversionisan
extension of the Service Provider that supports security. 1SC does not use those features, but
they are available under Windows NT for possible use by other DMI 2.0s-compliant software.
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NetWare

For installation on systems using NetWare, be aware of the following:

Connect as a user with supervisor rights when ingtalling 1SC to a NetWare server.

All NetWare servers require two manual reboots following the 1SC installation.

The TiRPC runtime library for ONC RPC or a substitute file set for NetWare5x must be
running.

Windows NT

For installation on systems using Windows NT, be aware of the following:

Connect as a user with supervisor rights when ingtalling 1SC to a Windows NT server.
The ISC ingtallation program automatically reboots both remote and local servers as necessary.

Remote Access Service (RAS) must be previously be installed on the console for if
connectivity will use amodem.

Windows 98 Second Edition

For installation on systems using Windows 98 Second Edition, be aware of the following:

A manual reboot is required following the ISC installation.
Remote Registry must be previously installed on the console.

UnixWare

For installation on systems using UnixWare, be aware of the following:

Connect asroot user when installing 1SC to a UnixWare server.

A plain text password must be enabled in the registry. If the password is not enabled, an extra
reboot following 1SC installation will be required on each UnixWare server.

Vision FS must be installed, configured, and running.

Mcopy must be installed on each 1SC managed UnixWare server. Please refer to the man page
for doscp for download and install instruction for mcopy. Mcopy can also be installed by
installing the mtool s package from Skunkware 7 CD-ROM.

A manual reboot is required for each server following the |SC installation.

The server automatically reboots following 1SC installation.

By default, SCO UnixWare v7.1.1 systems have DMI access set to read-only. This setting prevents
I SC from changing sensor thresholds, enabling the watchdog timer, and executing other functions.
To alow ISC to operate correctly, DMI access write permission must be enabled. Do the following
to enable DMI access to write:

1
2.

4,
5.

Loginas’root’.

Stop the DMI Service Provider (dmi stop).

Open thefile /etc/rc2.d/S89dmi for editing.

Changetheline $DM _PATH $@t0 $DM _PATH $@ - w.

Save the file and restart the DMI Service Provider (dmi start).

This changeisvalid for all future sessions.

12
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Red Hat Linux

For installation on systems using Red Hat Linux, be aware of the following:

* Remote ISC ingtalation is not available.
» Additional steps are required to configure the Linux DMI service provider.
e Additiona steps are required to configure the SNMP-DMI mapper.

Windows 2000

When upgrading to | SC 3.0, the previously installed service partition must be removed and
recreated using utilities supplied with ISC 3.0. The system BIOS must a so be upgraded.

Installation Guide for the Intel Server Control
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LSC, LDSM, Windows, NetWare, and UnixWare
Installation

The ISC package contains both the console and instrumentation software. To instal, launch
I|SCSetup.exeif it is downloaded from the web or Launch Binaries\Setup.exeiif it isfrom a
CD-ROM. Remoteinstallation for server instrumentation software is supported for

Windows 2000/NT or Novell server. The console software ingtallation can only be installed
locally. Select all the server(s) to be installed and follow the instruction on the screen to continue.
After the installation is completed, reboot the server to complete the installation:

wNE

No oM

Each Windows 2000/NT server automatically reboots.
Each NetWare, UnixWare, or Linux server requires manual reboot.

L ogin with system administrator access.

Verify the HP OpenView is not running.

Do steps 4 and 5 then skip step 6 if you are installing from the Software Kit CD. Skip to step 6
if you are installing from a download from the web.

At the console, insert the Software Kit CD into the CD ROM reader.

Run the program x:\binaries\setup.exe, where x in the drive letter of your CD ROM reader.
Run the program | SCsetup.exe from the ISC download directory.

Note thisinstallation may require multiple server reboots.

When installation is complete, view the file logfile in theinstall directory of each server and
console to verify that ISC installed correctly.

Red Hat Linux Installation

There are three stepsto Red Hat Linux installation process:

Installing Linux DMI server provider
Installing ISC
Configuring the SNMP_DMI mapper

Installing Linux DMI Service Provider

14
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0.

Insert the Software Kit CD into the console CD ROM reader.

Connect to the directory \isc\LinuxDMI.

Open an ftp session to the Linux server.

Change the mode to binary.

Copy thefiledm sp- 1. 0- 6. i 386. r pmto atemporary directory on the server.

Close the ftp session.

Login asroot on the server.

Uningtall ucd-snmp if it has been installed previoudy (with rpm —e ). Also remove all related
snmp packages and all related dmi packages. Remove the packages in a suitable order to
eliminate error messages about dependencies. If a dependency error messages appears, remove
the dependent package. Continue removing the dependent package until error messages stop.
Enter the command rpm —i <temp directory>/dmisp-1.0-6.i386.rpm and
press <Enter>.

10. Follow theinstruction on your screen.
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11. Reboot the Linux server when the command completes.
12. Repeat steps 3 through 9 for the files:

ucd-snnp-4. 1. 1- 15snux. i 386. rpm
ucd-snmp-utils-4.1.1-15snux. i 386.rpm
dm 2snnp- 1. 0-15.i 386. rpm

Installing ISC Server Instrumentation

1

O NOU WD

0.

Insert the Software Kit CD into the console CD ROM reader.

Connect to thedirectory \ i sc\ Li nux.

Open an ftp session to the Linux server.

Change the mode to binary.

Copy thefilel SC- 3. 0- 1. i 386. r pmto atemporary directory on the server.

Close the ftp session.

Login as root on the server.

Enter the command r pm —I <temp directory>/isc-3.0-1.i386 and press
<Enter>.

Following the instructions on your screen.

10. Reboot the Linux server when the command completes.

Configuring the SNMP-DMI Mapper

These steps must be completed if any SNMP management console (HP OpenView, CA UniCenter)
will manage the Linux server.

1

2.
3.

Verify that thedni 2snnp- 1. 0- 14. i 386. r pmanducd- snnp-4. 1. 1-

l4smux. i 386. r pmareinstalled.

Open thefile/ et ¢/ snnp/ snnpd. conf.

Add atrapsink line at the end of the file for each management console that receives traps from
the managed server. Thetrapsink line syntax is:

trapsink <nmyhost - nane. domai n. conp.
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Customizing NetWare Servers After Setup

Whileinstalling PIC, the configuration and Setup program installs Adaptec and LS| (Symbios)
SCSl, and Intel® LAN Adapter instrumentation on the NetWare server but does not enable the
instrumentation support.

To enable support for any or al instrumentation, you must edit the AUTOEXEC.NCF filein the
SYS:SYSTEM directory asfollows:

Add theline:
rpsstart. ncf

before the line:
i sc_on. ncf

To enable the Adaptec SCSI instrumentation, remove the word REM from these lines:
REM | oad si nti nw. nl m
REM | oad si nti nw. nl m

To enablethe Intel LAN Adapter instrumentation, remove the word REM from thisline:
REM | oad e100bdmi . nl m/auto

To enable the LSl (Symbios) SCSI instrumentation, remove the word REM from thisline:

REM | oad sinti nw. nl m
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Launching ISC

I SC can be launched from and can manage your server from one of these enterprise management
environments:

* LANDesk Server Manager (LDSM)

e HP Network Node Manager

*  CA-Unicenter TNG

Once the | SC application is launched from an enterprise management console, the management
consol e application can terminate, and | SC will continue to operate normally.

I SC can be launched from and can manage your server from a stand-alone I1SC Console. The ISC
Console can run as an executable program, as an ActiveX control within an Internet browser, or
within Microsoft Management Console.

LANDesk® Server Manager

The LANDesk Server Manager (LDSM) console dynamically builds its feature set when
communication is established with a managed server. If the managed server is running the ISC, the
LDSM console adds an option for “Intel Server Control” in the Tools branch of the LDSM
navigation tree. Select this option to launch ISC.

HP Network Node Manager

The HP Network Node Manager Console autodetects servers running the ISC Server
Instrumentation software. The Console updates the server bitmap with an ISC server icon for those
servers.

To launch the ISC applet, select an ISC-enabled server on the HP Console network map, and then
select the "Intel Server Control Applet" option from the Tools Menu. Alternatively, you can launch
ISC by selecting an ISC-enabled server on the HP console network map, clicking the right mouse
button, and then selecting the "Intel Server Control" option from the popup menu.

CA-Unicenter TNG

The CA-Unicenter TNG Console autodetects servers running the ISC Server Instrumentation
software if you have enabled the ISC to CA discovery service. To enable discovery, you must start
the "Intel Tng-ISC AutoDiscovery" service. You can start this service from either the TNG
Unicenter "Auto Discovery" dialog or from the Windows NT "Services" applet.

The "Intel Tng-ISC AutoDiscovery" service creates a new "Intel Server Control* TNG object for
each server having the ISC Server Instrumentation software. That TNG object displays on the map
as a child of the "ISC World View" and as a child of the ISC-enabled server. You can view all
ISC-enabled servers under the "ISC World View."
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To launch ISC, right-click on a "Intel Server Control" icon, and select the “Launch ISC" option
from the popup menu.

Stand-alone ISC Console

Use the stand-alone ISC Console to manage ISC-enabled servers without installing an enterprise
management console application. The environment is implemented as an executable program; as
an application within Microsoft Management Console; or as an ActiveX control that runs within a
“container” application, such as Microsoft Internet Explorer, versions 5.0 or later, or Netscape
Navigator, version 4.0 or later.

To launch the stand-alone ISC Console in its own container, do the following:

1. Click Start, and then point to Programs.
2. Point to Intel server Control Tool, and then point to Intel Server Control.

3. From the Start Menu in Windows, select Start->Programs->Intel Server Control Tools->Intel
Server Control.

Launching the ISC Console with Internet Browsers

To launch the stand-alone ISC Console within a Web browser, do the following:

1. Run the Internet Browser to be used as a “container” for the ISC Console.

2. Within the browser, choose File->Open.

3. Enter the ISC Console filename, specifying the full path to the file:
%ISCPATHY%\MNEMCAICAISC.HTM

The stand-alone ISC Console will be started as the active application within the default Web
browser.

Once the ISC Console is loaded, the location can be saved as a “Bookmark” (Netscape) or a
“Favorite” (Internet Explorer) for easy access in later sessions.
You may also:

1. Locate the file using Windows Explorer, specifying the path:
%ISCPATH%\MNEMC\AICNISC.HTM

2. Double-click on the filename to launch the control within the default Web browser.

[] NOTE

Netscape Navigator requires a plug-in for viewing ActiveX applications.
One that is known to work is ScriptActiyevhich is available from
Ncompass Labs, Inc. (see http://www.ncompasslabs.com).
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Launching the ISC Console with Microsoft Management Console

To launch the stand-alone 1SC Console within Microsoft Management Console (MMC), do the
following:

1. From a Start Menu in Windows or from the Start->Run selection, run MMC.
2. Within MMC, choose File->Open.
3. Enter the ISC Console filename, specifying the full path to the file:

%I SCPATHY%\MINEM C\IC\ISC.MSC

The ISC stand-alone application will be started as the active application within MMC. 'Y ou may
also:

1. Locate the file using Windows Explorer, specifying the path:
%I SCPATH%\MI\EMC\IC\ISC.MSC
2. Double-click on the filename to launch the control within MMC.

[1 NoOTE

If you have not installed MMC on your console system, you can obtain it from Microsoft at
http: //www.mi cr osoft.com/management/mmc/
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